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Following is a list of documentation icons:

Warning notices are used in this publication to emphasize that hazardous voltages,
currents, temperatures, or other conditions that could cause personal injury exist in
the equipment or may be associated with its use.
In situations where inattention could cause either personal injury or damage to
equipment, a Warning notice is used.

Caution provides information when careful attention must be taken in order to
avoid damaging results.

 Important flags important information.

To do calls attention to a procedure.

Note calls attention to information that is especially significant to understanding
and operating the equipment.

Tip provides a suggestion.

Guide provides additional directions for selected topics.

This document is based on information available at the time of publication.
While efforts have been made to be accurate, the information contained herein
does not purport to cover all details or variations in hardware or software, nor to
provide for every possible contingency in connection with installation,
operation, or maintenance.  Features may be described herein which are not
present in all hardware and software systems.  GE Fanuc Automation assumes
no obligation of notice to holders of this document with respect to changes
subsequently made.
GE Fanuc Automation makes no representation of warranty, expressed, implied,
or statutory with respect to, and assumes no responsibility for the accuracy,
completeness, sufficiency, or usefulness of the information contained herein.
No warranties of merchantability or fitness for purpose shall apply.
CIMPLICITY is a registered trademark of GE Fanuc Automation North
America, Inc.
Windows ME, Windows NT, Windows 98 and Windows 2000 are registered
trademarks of Microsoft Corporation.
Microsoft  is a registered trademark of Microsoft Corporation.
This manual was produced using Doc-To-Help®, by WexTech Systems, Inc.

Copyright 1999-2001 GE Fanuc Automation North America, Inc.
All rights reserved
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Contents of this Manual
Chapter 1. Introducing CIMPLICITY HMI Plant Edition. Covers what you
receive with a licensed or unlicensed system, a CIMPLICITY architecture
overview, system recommendations, distributor telephone numbers and
customer support telephone numbers.

Chapter 2. Installing CIMPLICITY. Describes how to start and proceed with
CIMPLICITY installation based on your computer setup and CD-ROM location.

Chapter 3. Registering CIMPLICITY. Provides procedures for first time
registration, registering new options and upgrades and using an unlicensed
version and the accompanying restrictions.

Chapter 4. Running the CIMPLICITY Demonstration Project. Describes
how to run a demonstration overview about CIMPLICITY and its applications
and use the demonstration project to open the CIMPLICITY Workbench.

Chapter 5. Using CIMPLICITY Help. Describes how to use a Help Table of
Contents, display help that is specific to an open application, install and use the
CIMPLICITY Book Reader, and provides a list of all printed copies of the
CIMPLICITY manuals from GE Fanuc Automation.
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Related Publications
For more basic information, refer to these publications:

CIMPLICITY HMI Plant Edition User's Manual (GFK-1180)
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Introducing CIMPLICITY HMI Plant
Edition

About CIMPLICITY Products
Welcome to GE Fanuc Automation's CIMPLICITY HMI product. The CD-
ROM you received contains all the software, plus all the documentation you
need to install, configure, and maintain your CIMPLICITY product
software..

If you are a first time user of CIMPLICITY, this Getting Started guide
will help you

� Install CIMPLICITY software.
� Register CIMPLICITY.
� Use the CIMPLICITY demonstration project.
� Discover the many ways to view online and electronic help.

This chapter covers:

� What you receive with a licensed or unlicensed system.
� A CIMPLICITY architecture overview.
� System recommendations.
� Distributor telephone numbers.
� Customer Support telephone numbers.
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What You Receive
If you have not purchased a licensed system, you should receive the
CIMPLICITY CD with distribution CD-ROM Liner Notes and this manual.  

If you purchased a licensed system, you should also receive:

� CIMPLICITY Software License agreement.
� Licenses for the Base System, Communication Enablers and

Options you purchased.
� An Important Product Information document for the current

software release.
� (If you purchased options) Optional documentation.

If you believe that items may be missing from your shipment, contact your
distributor. See page 1-6 for distributor telephone numbers.
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System Architecture
CIMPLICITY software is scalable from a Human Machine Interface to a
fully networked Supervisory Control and Data Acquisition (SCADA)
system. The networking capabilities inherent at all levels within the product
line let you achieve levels of integration that virtually eliminate redundant
configuration within a network.   

CIMPLICITY is based on a client server architecture consisting of Servers
and Viewers. Servers are responsible for the collection and distribution of
data. Viewers connect into Servers and have full access to the collected data
for viewing and control actions.

Servers and Viewers can be easily networked together to seamlessly share
data without the need to replicate your point database from node to node.
For example, points are configured once and only once on a server.  Screens
can be developed and stored in a single location on the network and
accessed by any other CIMPLICITY display on the network.

Servers can be licensed to collect data from, for example, 75, 150, 300, 700,
1500 or an unlimited number of device points. Exempted from the point
count are virtual points, which reside only in the computer and points
collected by another server. This I/O count architecture satisfies customers
with small single node systems, and leverages CIMPLICITY's strong
client-server architecture for multi-node systems.  CIMPLICITY provides
the flexibility to build a larger system through multiple smaller nodes
without forcing you to purchase large and expensive server hardware to
service multiple users.
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System Recommendations
Several factors contribute to determining the system requirements for your
CIMPLICITY configuration.

Factors include the:

� Number of points you are using,
� Number of CIMPLICITY applications,
� Number and size of log files and
� Number and size of CimView (graphic) files.

Following are recommendations for minimum requirements for a system. It
is strongly recommended that you do not use a system that goes below these
requirements.

You should also check the Important Product Information document
shipped with your release for any last-minute changes to these
recommendations.

Note: CIMPLICITY Server and Viewer software may be run on Microsoft
Windows NT Workstation and Microsoft Windows 2000, or Microsoft
Windows NT Server software. However, Microsoft Windows NT
Workstation imposes a limit of 10 network connections. Due to this
limitation, the number of remote client/server and device communication
connections may be limited. If you require connections to multiple devices
and/or multiple remote nodes, you should purchase Microsoft Windows
Server for these applications.
CIMPLICITY supports Windows 98 and Windows ME for Viewers.
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Hardware Requirements for CIMPLICITY
You will need a Pentium  class PC (we recommend 233 MHz or better), a
VGA monitor (Graphics Accelerator recommended), and access to a CD-
ROM drive. Depending on the system type, you will also need the
following:

System
Type

Operating
System

Minimum
Recommended
RAM

Minimum
Recommended
Free Hard Disk

Server Windows NT
Version 4.0
Windows 2000

128 MB 800 MB

Viewer Windows NT
Version 4.0
Windows 2000
Windows 98
Windows ME

128 MB 600 MB

If you plan to support third party drivers such as Data Highway Plus and
MODBUS Plus, you will need an ISA bus.

If you plan to network to other PCs or use the Series 90 TCP/IP driver, you
will also need an Ethernet adapter.

Software Requirements for CIMPLICITY
CIMPLICITY installation requires that you have Microsoft Internet
Explorer 5.5 or greater installed.
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Distributor Telephone Numbers
For more information about purchasing GE Fanuc products, call your
distributor.   

You can call the GE Fanuc Information Centers at the following numbers
for the location of your nearest GE Fanuc sales representative authorized
distributor:

USA and Canada (800) 648-2001
Europe (352) 727979-1
Asia Pacific (65) 566-4919
Latin America (610) 437-7932
Mexico (800) 989-1244

Customer Support
GE Fanuc takes pride in the high quality of CIMPLICITY software.  Great
emphasis has been placed on ensuring the quality of this system throughout
development and testing. However, the tremendous power that the software
offers may cause you to encounter problems or questions for your specific
configuration.

If your CIMPLICITY software system is under warranty or is covered by a
valid support contract, you may obtain assistance and report problems to the
CIMPLICITY Technical Support Help Desk at one of the following
numbers:

USA and Canada (800) GE-FANUC or (800) 433-2682
All others (804) 978-6036

The CIMPLICITY Help Desk is available from 8 A.M. to 8 P.M. Eastern
Time, Monday through Friday, except for regularly scheduled USA
holidays.
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Installing CIMPLICITY HMI

About CIMPLICITY HMI Installation
CIMPLICITY HMI installation is straightforward. You simply need to:

� Start CIMPLICITY HMI installation based on your computer setup
and CD-ROM location.

� Proceed with CIMPLICITY HMI installation.
In addition to the two topics above, this chapter covers:

� New option installation.

CIMPLICITY HMI Installation Startup
Starting up CIMPLICITY HMI installation is similar to other Windows
based software.  The exact procedure depends on whether you are using a:

� Local CD-ROM drive.
� Shared CD-ROM drive.

Using a Local CD-ROM Drive to Install CIMPLICITY HMI
Installation from a local CD-ROM drive is straightforward.

To install CIMPLICITY HMI software from a local CD-ROM drive:
Once you have placed the CIMPLICITY HMI Distribution CD-ROM in the
CD-ROM drive.

Automatic startup enabled:

 The installation procedure starts automatically.

Automatic startup disabled:

1. Open the Windows Explorer.
2. Select the CD-ROM drive.
3. (For a network computer that is different from the computer that

holds the CD) map a drive to the computer that holds the CD.
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4. (For all computers) select isetup.exe on the CIMPLICITY
HMI Distribution CD.

Using a Shared CD-ROM Drive to Install CIMPLICITY HMI
If you are using a shared CD_ROM drive, you will need to take some
simple steps on both the computer with the CD-ROM drive and the
computer on which you will install CIMPLICITY HMI. .

To prepare shared computers for CIMPLICITY HMI installation:
On the computer with the CD-ROM drive:

1. Open My Computer.
2. Select the CD-ROM drive.
3. Click the right mouse button and select Sharing... from the pop-up

menu.
4. Select the Sharing tab for the drive.
5. Select Shared As.
6. Enter a name in the Share Name field.
7. Click OK.

On the computer where you want to install CIMPLICITY HMI:

1. Open My Computer.

2. Click the Map Network Drive button  on the Toolbar.
3. Select a Drive.
4. Specify a path to the shared CD-ROM.
5. Click OK.

Result: You can now open the shared drive and select isetup.exe on
the CIMPLICITY HMI Distribution CD.
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CIMPLICITY HMI Installation
The CIMPLICITY HMI installation is straightforward. These steps describe
how to install both new products and upgrade versions, which require one
additional step in the process.

Step 1. Begin the CIMPLICITY HMI 5.5 installation.

Step 2. Choose the CIMPLICITY Server, Viewer or Demo.

Step 3. Choose CIMPLICITY Server or Viewer options.

Step 4. Install CIMPLICITY.

Step 5. Complete CIMPLICITY 5.5 installation.

Step 1. Begin CIMPLICITY HMI 5.5 Installation
1. Insert the CIMPLICITY HMI 5.5 CD in the CD-ROM drive.

A CIMPLICITY HMI Setup screen appears.

2. Click Install CIMPLICITY HMI.
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3. Review the Welcome Screen

3. Click Next.
4. Review the license agreement in the Software Evaluation License

Agreement screen.

6. Click Yes to agree to the licensing terms.

Result: CIMPLICITY HMI installation looks to see if a registered
version of CIMPLICITY HMI exists on your server. If your
CIMPLICITY HMI installation is a first time or upgrade installation.
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� First time installation,

A CIMPLICITY HMI Product Options screen appears.

� Upgrade installation,

A CIMPLICITY HMI Setup screen appears with
Upgrade\Reinstall checked.

Click Next.
A CIMPLICITY HMI Product Options screen appears.

Note: The following dialog boxes appear if you check Review/Add
options. See page 2-8.
When Installing Dialog that Appears
HMI Server HMI Server Options dialog box
Development Viewer Development Viewer Options dialog box
Runtime Viewer Viewer Options dialog box
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Step 2. Choose CIMPLICITY HMI Server, Viewer or Demo
You can choose a HMI Server, Viewer or Demo on the CIMPLICITY HMI
Product Options screen.   

You can also select to install the demo when you install the CIMPLICITY
HMI Server.

Choose among:

HMI Server
Click the HMI Server button to select options for the HMI Server
system. See page 2-7

Viewer
A. Click Viewer.

A CIMPLICITY HMI Setup screen appears.

B. Check either:
� Viewer Runtime, or
� Viewer Development.
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C. Click Next.
The Choose Destination Location screen appears. See "For the HMI
Server, Viewer and Demo" in this step to continue.

Demo

Click the Demo button to select the demo only. (Continue next).

For the Server, Viewer and Demo:

Choose the CIMPLICITY HMI Destination.

When Installing Dialog that Appears
HMI Server HMI Server Options dialog box
Development Viewer Development Viewer Options dialog

box
Runtime Viewer Viewer Options dialog box
Demo Choose Program Group (Step 4)

Result: Go to the next step to select the features and options you want to
install for the server or viewer. Go to Step 4 (page 2-10) to continue
installing the demo.
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Step 3. Choose HMI Server or Viewer Options
The options available to you depend on whether you are installing:

� HMI Server
� Development Viewer, or
� Runtime Viewer.

HMI Server or Development Viewer Options
Choose the server or development viewer options you want to install in the
HMI Server (or Development Viewer) Options dialog box.

Guidelines for selecting options
� Check a component's check box in the left column to select all of the

options (in the right column) for the checked component. You can
uncheck any options you do not want to install.

� Select the component (without checking it) to display, but not select
options in the right column. You can check any options you want to
install.

To choose HMI server or development viewer options:
1. Select Application Options in the Components box.
2. Check or uncheck the options you want to be installed or not to be

installed.
3. Select Communications, which is automatically checked, in the

Components box.
4. Check or uncheck the options you want to be installed or not to be

installed.
5. Select System Utilities, which is automatically checked, in the

Components box.
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6. Uncheck the options you do not want installed.
7. (Recommendation) Leave Demo checked in the left column to

help you learn about CIMPLICITY HMI and/or its new features.
6. Check Tracker and Tracker Display (and right column features)

if those options, for which you will need a license, are available
with your CIMPLICITY HMI product.

7. Click Next.
Result: The Choose Program Group dialog box appears.

CIMPLICITY HMI Runtime Viewer Options
Choose the runtime viewer options you want to install in the Runtime
Viewer Options dialog box.

To choose CIMPLICITY HMI runtime viewer options:
1. Check the components you want in the Components box.
2. Check any options you want that are available with a selected

component.  
3. Click Next.
Result: The Choose Program Group dialog box appears.
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Step 4. Install CIMPLICITY HMI
A default Program folder displays in the Program Folders field in the
Choose Program Group dialog box.

1. Select a program folder for CIMPLICITY HMI.   
2. Click Next when the name you want appears in the Program

Folders field.

Result: Installation begins.

A series of messages appear to inform you of the CIMPLICITY HMI
installation progress.   

Messages include:

Result: When installation is complete a Registration screen appears.
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Step 5. Complete CIMPLICITY HMI Installation
At this point, you are given an opportunity to register your CIMPLICITY
HMI software.

After you install your software, you have a four days grace period to
register it. During this grace period, you will have full access to the base
system and all communication enablers and options you installed. If you
have not licensed your software by the end of the grace period, your system
becomes unlicensed and you have restricted functionality. See "CIMPLICITY
HMI with no License" section in the "Registering CIMPLICITY HMI" chapter in this
manual.

1. In the Registration window either:
A. Click Yes to register during installation. See the "Registering

CIMPLICITY HMI " chapter in this manual for details about
registering CIMPLICITY HMI.

B. Click No to register later.

When you have completed registration or if you click No, a Setup
Complete dialog box appears.
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3. Either:
A. Check Yes, I want to restart my computer now to make

CIMPLICITY HMI immediately available for use, or
B. Check No, I will restart my computer later.   

4. Click OK.

Result: Setup is complete.
If you installed the HMI Server or Viewer, you can begin to take full
advantage of CIMPLICITY HMI as soon as the computer reboots
and you have registered with GE Fanuc Automation.

If you installed the Demo a Start Demo icon appears on
your desktop after you reboot.
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CIMPLICITY HMI New Option Installation
You can quickly add new options to your CIMPLICITY HMI installation.

To add a new product option to your installation:
1. Click isetup.exe on the CIMPLICITY HMI distribution CD-

ROM.
2. Select Install CIMPLICITY HMI.
3. Proceed to the CIMPLICITY HMI Setup dialog box.
4. Click Review/Add Options.

The Options dialog box appears for your specific installation.

5. Select the options you want to add to your installation.
6. Reboot your computer when the installation is completed.
7. Remember to register your new options.

Note: The procedure to install a new option is different if you have a
service pack installed. See the "System Administrative Issues" appendix in the
CIMPLICITY HMI Plant Edition Base System User's Manual, GFK-1180, for
details.
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Registering CIMPLICITY HMI

About CIMPLICITY HMI Software Registration
If you purchased a licensed CIMPLICITY HMI system, you will need to
register your software in order to access its full functionality.

Note: If you do not register your software, or you are running a Demo
system, see page 3-22 for details.
If you want to transfer licenses, see "CIMPLICITY HMI License Transfer" in the
"CIMPLICITY Administrative Issues" appendix of the Base System User's
Manual (GFK-1180).

This chapter provides procedures for:

� First time registration. See page 3-8.

� Registering new options and upgrades. See page 3-11.

� Using an unlicensed version and the accompanying restrictions. See
page 3-22.

Important:  Once you register CIMPLICITY HMI, the registration files,
*.key, *.rst, *.41s and *.ent, must stay in the same place on the
hard disk. If you use a utility (e.g. defragmentation) that changes the
location of these files, you will lose your registration. Consult the utility
documentation for possible ways to protect these files.
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CIMPLICITY HMI First Time Registration
You will supply GE Fanuc Automation with a generated system key code
when you register CIMPLICITY HMI.

You can easily:

� Prepare for registration to obtain the generated system key code (next).
� Complete first time registration. See page 3-8.

Preparing for CIMPLICITY HMI Registration
The tasks to prepare for CIMPLICITY HMI registration include:

Step 1. Open CIMPLICITY HMI Registration: instructions.

Step 2. Agree to the CIMPLICITY HMI Licensing terms.

Step 3. Enter user information.

Step 4. Enter your Base System serial number.

Step 5. View a Generated system key code.
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Step 1. Open CIMPLICITY HMI Registration: Instructions
1. Select CIMPLICITY>HMI on the Windows Start menu.
2. Select Registration.

.

The CIMPLICITY® Registration Instructions screen opens.

3. Click New Registration.
4. Click Next to continue with registration.

Result: The Registration License Agreement screen appears.
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Step 2. Agree to the CIMPLICITY HMI Licensing Terms

1. Read the license agreement in CIMPLICITY® Registration:
License Agreement screen.

2. Click Yes.

Result: A CIMPLICITY® Registration: User Information dialog box
opens.
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Step 3. Enter User Information

1. Enter company contact name, company name, address, telephone
number, fax number and email address in the CIMPLICITY®
Registration: User Information dialog box.  
When you request your System Authorization Code you will need
to furnish your GE Fanuc Automation representative with the
information that you enter.

Note: The license is issued to a company, not to an individual.

2. Click Next.
Result: The CIMPLICITY® Registration: Serial Numbers dialog box
appears.
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Step 4. Enter Your Base System Serial Number

1. Enter the serial number for your base system in the Serial no. field
in the CIMPLICITY® Registration: Serial Numbers dialog box.

You can find the serial number in the CIMPLICITY HMI
registration envelope that is included in the CIMPLICITY HMI
system package.

2. Click Next.
Result: The CIMPLICITY® Registration: Authorization screen
opens.
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Step 5. View a Generated System Key Code
When a correct base serial number is entered CIMPLICITY HMI
registration generates a system key code that displays on the
CIMPLICITY® Registration: Authorization screen. You will supply the GE
Fanuc Automation representative with this code.

Automatically
generated when
correct serial
number is
entered.

Click Next.
Result: The CIMPLICITY® Registration System Authorization
Code dialog box opens.

Obtain from
GE Fanuc by
phone or fax.

Result: CIMPLICITY HMI is ready for registration.
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Completing First Time Registration
The last procedure in registering your CIMPLICITY HMI software is to
enter the authorization code, so you can reap the full benefit of registration.

You can call and talk directly with a GE Fanuc Automation representative
or you can fax or email your information.

Fax: (780) 420-2049
Phone: (780) 420-2007 or

1-800-647-4196
Email: Authorization@gefedmonton.ge.com
Faxes and telephone calls are processed:

� Between 10 A.M. and 6 P.M. Eastern Standard time,
� Monday through Friday, except for regularly scheduled holidays.

Faxes and calls received after hours, on weekends, or holidays are
processed as soon as possible on the following business day.

The information you provide GE Fanuc Automation is:

� User information, including name, company, street and email
addresses and telephone and fax numbers.

� Serial number(s) found in the CIMPLICITY HMI Registration
envelope.

� System Key Code generated during the registration procedure.
� CIMPLICITY HMI version number.

Based on the information you provide your GE Fanuc Automation
representative, you will be given a System Authorization Code.

To enter the System Authorization code:
Note: If you have the CIMPLICITY HMI Registration application open, go
to number 8 in this procedure to continue.

1. Double-click the Registration icon in the CIMPLICITY HMI
program group to restart the CIMPLICITY HMI registration
procedure.

2. Proceed to the Registration Instructions dialog box.
3. Make sure the New Registration radio button is selected
4. Click Next.

The License Agreement dialog box opens.

5. Click Yes.

The CIMPLICITY® Registration: Serial Numbers dialog box
opens.
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6. Click Next.
The CIMPLICITY® Registration: Authorization screen opens.

7. Click Next.
The CIMPLICITY® Registration: System Authorization Code
dialog box opens.

8. Enter the Authorization Code you received from GE Fanuc.

Obtained from
GE Fanuc
through the
Internet or by
phone or fax.

9. Click Next.
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The CIMPLICITY® Registration: Finish screen appears.

10. Reboot your computer.

Congratulations. You have successfully registered your CIMPLICITY
HMI software.

You now have full access to the CIMPLICITY HMI Base System and all
CIMPLICITY HMI options that you installed and registered.
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CIMPLICITY HMI New Option Registration
In order to unleash the full functionality of a new CIMPLICITY HMI
option or upgrade, it has to be registered.

You do not need to call or fax GE Fanuc automation to register your
CIMPLICITY HMI software options.

Important: Do not change the base serial number when you enter new
options through the CIMPLICITY® Registration: Welcome dialog box.

To register the new product option:
1. Install the product option.
2. Open the Registration program.
3. A CIMPLICITY® Registration: Welcome dialog box opens.

Important: Do not change the number in the Serial no. field.

4. Click Add.

The Product Serial Number dialog box opens.

5. Enter the serial number that appears on the option's License sheet
in the Serial number field.
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The name of the option appears in the Product field.

6. Click OK.

The product option, with an unlicensed status, appears in the
Options and Versions upgrades list in the CIMPLICITY®
Registration: Welcome dialog box.

7. Click Next.
The CIMPLICITY® Registration: License Agreement screen
appears.

8. Click Next.
The CIMPLICITY® Registration: Finish screen appears.

8. Reboot your computer.

Result: If you display the CIMPLICITY® Welcome dialog box after
you reboot you will see that the option's status has changed to
Licensed.
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CIMPLICITY HMI Upgrade Registration
There are two types of CIMPLICITY HMI upgrades - functional and
version.   

� A functional upgrade enables you to upgrade a CIMPLICITY
HMI system to a higher device I/O count, from a runtime to a
development system or from a Viewer to a Server.

� A version upgrade enables you to upgrade to the latest version of
software.

The procedure you follow for registration depends on if you are
upgrading from

Registering a Functional Upgrade
CIMPLICITY HMI systems are available with a choice of device I/O
counts (for example, 50, 75, 150, 300, 700 and unlimited) for both
Development and Run-time systems.

You can make any of the following functional upgrades:

� From a lower to a higher point device I/O count
� From a Run-time to a Development system
� From a Viewer to a Server

Contact your distributor for complete information about placing a functional
upgrade order.

To register a functional upgrade:
1. Open the Registration program.
2. A CIMPLICITY® Registration: Welcome dialog box opens.
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3. Click Change.

4. Enter the applicable serial number for the base system you are
registering.

5. Click Next.
The CIMPLICITY® Registration: Authorization dialog box opens.

Automatically
generated when
correct serial
number is
entered.

6. Contact GE Fanuc with the new base serial number and System
Key Code to obtain a new System Authorization Code.
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7. Click Next.
8. Enter the new System Authorization Code in the CIMPLICITY®

Registration: System Authorization Code dialog box.

Obtained from
GE Fanuc
through the
Internet or by
phone or fax.

9. Click Next.
The CIMPLICITY® Registration: License Agreement screen
appears.

10. Click Next.
The CIMPLICITY® Registration: Finish screen appears.

11. Reboot your computer.

Result: If you display the CIMPLICITY® Registration: Welcome
dialog box after you reboot you will see that the upgrade's status has
changed to Licensed.

Note: If you want to add additional options to the functional upgrade, you
do not need to contact GE Fanuc. Simply enter a valid serial number for
each option you have purchased and want to enable. See page 3-19 for details.
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Registering a Version Upgrade
A Version Upgrade takes an older CIMPLICITY HMI system and upgrades
it to the current version. Contact your distributor for complete information
about ordering a Version Upgrade.

The procedure you follow to register a version upgrade depends on whether
your current version is:

� CIMPLICITY HMI V3.0 or higher or
� Less than CIMPLICITY HMI V3.0.

Note: If you current installation is CIMPLICITY HMI 4.01 in the 90-day
warranty period, the version upgrade is provided at no charge.

If your current version is out of the 90-day warranty period, you must
purchase the version upgrade.

You will receive an upgrade license (either from your distributor or directly
from GE Fanuc) when you purchase an upgrade. Use the Registration
program to add the new license to your current set of installed licenses.

Registration for CIMPLICITY HMI V3.0 or Higher Upgrade

Note: If you are upgrading from version 3.0 of CIMPLICITY HMI
software, you do not need to contact GE Fanuc for a new System
Authorization Code.

Important: Do not change the base serial number when you enter new
options through the CIMPLICITY® Registration: Welcome dialog box.



GFK-1500C Registering CIMPLICITY HMI 3-17

To upgrade from CIMPLICITY HMI V3.0 or higher:
1. Purchase the upgrade.
2. Back up your current CIMPLICITY HMI projects.
3. Install the new CIMPLICITY HMI version.
4. Open the Registration program after installation.
5. A CIMPLICITY® Registration: Welcome dialog box opens.

Important: Do not change the number in the Serial no. field.

6. Click Add.
The Product Serial Number dialog box opens.

7. Add your upgrade serial number in the Serial number field.

8. Click OK.

The new version, with an unlicensed status, appears in the Options
and Versions upgrades list in the CIMPLICITY® Registration:
Welcome dialog box.

9. Click Next.
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The CIMPLICITY® Registration: License Agreement screen
appears.

10. Click Next.
The CIMPLICITY® Registration: Finish screen appears.

11. Reboot your computer.

Result: If you display the CIMPLICITY® Registration: Welcome
dialog box after you reboot you will see that the version's status has
changed to Licensed.

Registration for Less than CIMPLICITY HMI V3.0 Upgrade
You will receive an upgrade license (either from your distributor or directly
from GE Fanuc) when you purchase an upgrade. Use the Registration
program to add the new license to your current set of installed licenses.

Important: If you are upgrading from a version prior to v3.0, you must
contact GE Fanuc for a new serial number and, during installation, for a
System Authorization Code.

To upgrade from a CIMPLICITY HMI version that is lower than
v3.0:

1. Prepare for upgrade registration as follows:
A. Purchase the upgrade product.
B. Back up your current CIMPLICITY HMI projects.
C. Contact GE Fanuc for a new product serial number.
D. Install the new CIMPLICITY HMI version.
E. Open the Registration program after the installation.
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2. A CIMPLICITY® Registration: Welcome dialog box opens.

Important: Do not change the number in the Serial no. field.

3. Click Add.

The Product Serial Number dialog box opens.

4. Add the new serial number in the Serial number field.

5. Click OK.

The new version, with an unlicensed status, appears in the Options
and Versions upgrades list in the CIMPLICITY® Registration:
Welcome dialog box.
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6. Click Next.
The CIMPLICITY® Registration: Authorization dialog box opens.

Automatically
generated when
correct serial
number is
entered.

7. Contact GE Fanuc with the:
� Serial number for your original license
� Serial number for your upgrade license
� Serial numbers for any other CIMPLICITY HMI product

options in use on the system you are upgrading
� New System Key Code generated by Registration

8. Click Next.
The CIMPLICITY® Registration: System Authorization Code
dialog box appears.
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9. Enter the new System Authorization Code in the CIMPLICITY®
Registration: System Authorization Code dialog box.

Obtained from
GE Fanuc
through the
Internet or by
phone or fax.

10. Click Next.
The CIMPLICITY® Registration: License Agreement screen
appears.

11. Click Next.
The CIMPLICITY® Registration: Finish screen appears.

12. Reboot your computer.

Result: If you display the CIMPLICITY® Registration: Welcome
dialog box after you reboot you will see that the version's status has
changed to Licensed.

Note: If you want to add additional options to the functional upgrade, you
do not need to contact GE Fanuc. Simply enter a valid serial number for
each option you have purchased and want to enable. See page 3-19 for details.
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CIMPLICITY HMI with No License
You can run CIMPLICITY HMI software without a license in order to
demonstrate or test CIMPLICITY HMI software.   

You will be able to:

� Run the CIMPLICITY HMI Demo project or any other existing
project for two (2) hours.

� Create and view screens using CimEdit and CimView.

The following runtime restrictions also apply:

� You cannot create, modify, copy or delete points in any project.
� On an unlicensed Server or Viewer node, you cannot communicate

with CIMPLICITY HMI applications on other computers.
� An unlicensed device communications enabler (devcom) will run

for only two hours regardless of whether the base system has been
licensed or not.
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Running the CIMPLICITY HMI
Demonstration Project

About CIMPLICITY HMI Demos
CIMPLICITY HMI includes a demonstration project that showcases the
features of CIMPLICITY HMI software.

You can use the demonstration project in two important capacities:

1. Run a demonstration overview about CIMPLICITY HMI and its
applications (next).

2. Use the demonstration project to open the CIMPLICITY HMI
Workbench, which is at the center of a project's configuration. The
demonstration project provides you with a useful reference when
you are in the Workbench and learning about CIMPLICITY HMI's
many features. See page 4-9.

This chapter describes how to use the CIMPLICITY HMI demonstration
project in the two capacities listed above.
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CIMPLICITY HMI Demonstration
Take some time to run the CIMPLICITY HMI demonstration. If you are a
new CIMPLICITY HMI user, the demonstration will provide you with a
valuable perspective of how CIMPLICITY HMI fits into a working
environment. If you are a new or experienced user you can review
descriptions and examples of CIMPLICITY HMI's numerous features and
options.

This demonstration, which is divided into Setup, Plant Simulation, About
CIMPLICITY HMI and Applied sections enables you to explore
CIMPLICITY HMI's potential from several different perspectives.

The demonstration was constructed in and through CimEdit, CIMPLICITY
HMI's interface editor. You view it in CimView, the CIMPLICITY HMI's
runtime interface.

This section describes:

� How to start the CIMPLICITY HMI demonstration (next).
� Demo Section 1. Demo (audio) Setup.  See page 4-4.

� Demo Section 2. Plant simulation. See page 4-5.

� Demo Section 3. About CIMPLICITY HMI. See page 4-6.

� Demo Section 4. CIMPLICITY HMI applied. See page 4-7.

� How to adjust the screen and window size. See page 4-8
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Starting the CIMPLICITY HMI Demonstration
If you installed the:

� CIMPLICITY HMI Server or Viewer you start the Demonstration
from the Windows Start menu.

� CIMPLICITY HMI Demo, you double-click the Demo shortcut

icon on the Windows desktop.

To start the CIMPLICITY HMI demonstration on a Server or
Viewer:

1. Select CIMPLICITY>HMI>Start Demo on the Windows Start
menu.

 The Starting CIMPDEMO dialog box appears.

2. Click Close when the dialog box stops scrolling.

Result: The main screen for the demonstration appears.
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Demo Section 1. Demo (Audio) Setup
Demo Setup on the CIMPLICITY HMI demonstration main screen
enables you to select the voice you prefer to speak to you about
CIMPLICITY HMI and its numerous features and capabilities.

1. Click to read an explanation of how to start and select a
voice.

Display a help screen.

Listen to an audio
explanation as your cursor
guides you on the screen.

2. Click  to listen to an explanation of how to use the Demo
Setup screen.

The cursor automatically points to the area that is being described.
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Demo Section 2. Plant Simulation
Plant Simulation provides you with an extraordinary array of
configuration possibilities. What makes this section particularly valuable is
that the possibilities are in an example application, thereby giving you a
practical context for exploring ideas and solutions, not just for an
introduction but anytime you need inspiration when designing your own
systems.

Note: This section is best viewed with the screen set to at least 65636
colors.

To text and audio
description of screen.

Click  to open a text description of the screen.

The Audio button, , is on the text screen.

Note: If a sound card and driver are not installed on the computer, the
CIMPLICITY HMI Demo displays an error message when you click
TELLME.
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Demo Section 3. About CIMPLICITY HMI
About CIMPLICITY HMI provides you with descriptions and examples of
CIMPLICITY HMI features, options and Enterprise solutions in a list
format. In addition, the formats and tools incorporated in each description
provide you with more exciting possibilities of what you can do using
CIMPLICITY HMI.

About CIMPLICITY Integration Screen Select a tab to review features,
options and enterprise solutions.

Tip: Click any button in one of the three lists to see a more detailed
description and/or an example of the selection.

Click a button to display an
explanation and/or example.

Trend Example Displayed
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Demo Section 4. CIMPLICITY HMI Applied
CIMPLICITY HMI Applied provides you with example CimView screens
for several different applications.

1. Select a topic.

2. Click for a
demonstration of the
selected topic.

Demonstration Applied Screen

To view an application example in the Demonstration Applied
screen:

1. Select the topic.

The graphic on the Demo button changes to reflect your selection.

2. Click the Demo button.

A CimView screen that displays the application opens.
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Adjusting the Screen and Window Size
You can easily adjust any CimView screen's size at any time during the
demonstration. You can then fit the window to the new screen size. It is
recommended that you adjust the screen to the best fit.

To adjust a screen's size to best fit:
1. (If the screen's menu is not displaying) right-click on the screen.

The screen's popup menu displays.

2. Select Menu/Title Bar.

A menu displays at the top of the screen.

3. Click View on the screen's menu bar.
4. Select Zoom to Best Fit.
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Demonstration Project in the CIMPLICITY HMI
Workbench

Because the demonstration project that contains the configuration for the
CIMPLICITY HMI demonstration is a CIMPLICITY HMI project, it can be
opened, like any other project, in the Workbench.

As a result, when you open the Workbench and begin configuring your own
projects, you have a valuable reference tool.

Note: If you ran the demonstration, the project will be running when you
open the Workbench.

This section describes how to:

� Display the demonstration project in the CIMPLICITY HMI
Workbench

� Start and stop a project

Displaying the CIMPLICITY HMI Demonstration Project in
the Workbench

You display the CIMPLICITY HMI demonstration project in the
Workbench. You can learn more about CIMPLICITY HMI configuration
when you are in the Workbench, because all of the documentation is
available through the Workbench.

Note: Documentation is also available through the Windows Start menu.

To display the CIMPLICITY HMI demo project:
1. Select CIMPLICITY HMI on the Windows Start menu.
2. Select HMI.
3. Select Demo Project
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The CIMPLICITY HMI Workbench opens with the demonstration
project loaded.

Screens.

Points.

Application folder.

Objects in
application.

Expand the tree.

Collapse the tree.

Pane for CIMPLICITY
applications.

Pane for files or records associated
with a selected application.

The Workbench provides you with an elegantly simple format through
which you can access all the tools for your project's configuration.

� Across the top are the menu and toolbars.
� The left pane displays all of the applications you need, either alone

or in folders that contain related applications.
� The right pane displays files or records associated with a selected

application.
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Starting and Stopping a CIMPLICITY HMI Project
When you open the Workbench using the demonstration project, if you:

� Did not run the Demonstration, the project will be loaded in the
Workbench, but will not be running.

� Ran the Demonstration, the project will be loaded in the
Workbench and will be running. Stop the project before you exit
the Workbench.

This section describes how to start and stop a project.

Techniques to Start a CIMPLICITY HMI Project
CIMPLICITY HMI provides several methods, from which you can choose
what is most convenient for you, to carry out a task. Therefore, you can start
a project using the Workbench toolbar, menu item or the keyboard.

To start an open CIMPLICITY HMI demonstration project in the
Workbench:
Method 1–Use the toolbar

Click the Run button  on the Workbench toolbar.

Method 2–Use a menu item

1. Click Project on the Workbench menu bar.
2. Select Run.

Method 3–Use the keyboard

Press Ctrl+R on the keyboard.

Method 4–Use the keyboard
1. Press Alt+P on the keyboard.
2. Press R.

A CIMPLICITY HMI Configuration dialog box opens asking you if it
is ok to run the project, when you use any method.
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Continue after using any method

1. Click OK.

The Starting CIMPDEMO dialog box opens and scrolls the names
of the processes as they are opened.

2. Click Close when the scrolling stops.

The demonstration project is running.

Techniques to Stop a CIMPLICITY HMI Project
A CIMPLICITY HMI project will continue to run after the Workbench is
closed. There are several methods to make it stop, if you want it to.

To stop a running CIMPLICITY HMI demonstration project in the
Workbench:
Method 1–Use the toolbar

Click the Stop button  on the Workbench toolbar.

Method 2–Use a menu item

1. Click Project on the Workbench menu bar.
2. Select Stop.

Method 3–Use the keyboard
1. Press Alt+P on the keyboard.
2. Press S.

A CIMPLICITY HMI Configuration dialog box opens asking you if it
is ok to stop the project, when you use any method.

Continue after using any method

Click OK.

The demonstration project stops running.
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Using CIMPLICITY HMI Help

About CIMPLICITY HMI Help
CIMPLICITY HMI offers you several options to get help. You can:

� Use a Help Table of Contents to review all online help topics
(next).

� Display help that is specific to an open application. See page 5-3.

� Install and use the CIMPLICITY HMI Book Reader to read and
print help in a book format. See page 5-4.

� Purchase any or all printed copies of the manuals from GE Fanuc
Automation. See page 5-14.

Note: When you use the Book Reader, you can read the printed manuals in
electronic format.

Help for each application.

Book Reader Workbench HelpOnline Help TOC
CIMPLICITY Workbench Help
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Table of Contents for Online Help
There are several methods for opening the CIMPLICITY HMI Table of
Contents; these methods provide you with access to all online Help Files.

To open the CIMPLICITY HMI Table of Contents:
Method 1

1. Select CIMPLICITY on the Windows Start menu.
2. Select HMI>CIMPLICITY Help.

Method 2

1. Click Help on the Workbench menu bar.
2. Select Contents.

Result: A Help Topics dialog box that lists the help files for all installed
CIMPLICITY HMI applications opens.

Click to display  the
topic's TOC.

Expand to display
topics.
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Help Specific to an Application
You can easily view help that is specific to any open dialog box or window.

To view specific help in an open dialog box or window:
Click the Help button or press F1 on the keyboard.

Help Specific to an Application
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The Book Reader
 provides an electronic book reader based on Adobe® Acrobat®. The Book
Reader enables you to easily search, view, and print out any of the
CIMPLICITY HMI documentation.

The complete CIMPLICITY HMI library of documentation is stored on the
product CD.  All documents have been electronically indexed, which allows
the book reader to quickly scan volumes of information and find the topics
you are seeking.

The Adobe Acrobat Reader Online Guide, and Adobe Acrobat Search
Online Guide provide detailed documentation for using Adobe Acrobat.

Important: For Windows 2000 users:
If your printer does not print the .pdf files correctly, check Print as
image in your printer's Setup or Print dialog box.

This problem seems to only affect certain printers in PCL mode. You may
also be able to switch the printer driver to a PostScript driver as a solution.
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Installing the Book Reader
You install the Book Reader separately from the CIMPLICITY HMI CD.

To install the electronic book reader:
1. Run the isetup.exe file on your  CD.  The CIMPLICITY HMI

Setup window opens.
2. Select Install Documentation Reader from the list of options in the

CIMPLICITY HMI Setup window.
3. Verify that you want to install Adobe Acrobat Reader v.4.0
4. Accept the license agreement.
5. Choose a destination location for the Adobe Acrobat Reader.
6. When setup is complete, you have to option to review the Adobe

Acrobat Reader Readme file.

Opening the Book Reader
There are several methods for opening the Book Reader.

To open the Book Reader:
Method 1

1. Click CIMPLICITY on the Windows Start menu.
2. Select HMI.
3. Select CIMPLICITY Book Reader.

Method 2

1. Click Help on the Workbench menu bar.
2. Select Book Reader.

Method 3
1. Click the Book Reader button on the Workbench toolbar.

Result: The Book Reader opens when you use any method.
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Looking Over the Book Reader
When you open the CIMPLICITY Book Reader, an Overview document
that lists all of the available manuals displays.

Click any manual title. The manual it represents opens.

1 Click a manual title.
2 The selected manual opens.

A list of manuals appears when
the Book Reader is opened.

The Acrobat Reader window is divided into two panes.

� The left pane displays the manual bookmarks or thumbnails.
� The right pane displays the current document page.

Note: You can press F1 at any time to display the Adobe Acrobat Reader
Online Guide.  This online documentation shows you how to navigate
through the on-line books and use the Find features of the Book Reader.
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Changing the Book Reader View
The Book Reader provides several options to adjust what you are viewing.
Options include:

� Changing the display size.
� Changing the page display format.
� Displaying a specified page number in the displayed document.
� Displaying pages that contain specified text in the displayed

document.
� Displaying pages that contain specified text in all of CIMPLIITY

HMI's documentation.

Book Reader Page Display Size
Any page in the Book Reader can be displayed up to 800% magnification.

To change the display size of a page in the Book Reader:
Method 1

Select Zoom In… or Zoom Out… on the View menu.

Method 2

1. Select Zoom To… on the View menu (opens the Zoom To dialog
box) or the Size button on the bottom toolbar.

2. Specify a percent size in the Size field.

View Menu and Bottom Toolbar Button

Tip: The graphics display the best when screen resolutions are 1024x768 or
higher and the document is magnified.
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Book Reader Page Display Format
The pages can be viewed alone as two facing pages, similar to a book.

Either pane can be displayed or hidden.

The left pane can display either bookmarks or thumbnails of a page.

To change the display format:
Select the desired options on the View and Window menus or click the
complementary buttons on the bottom toolbar.

Window menu Bookmark display.

View menu page display style.

Menu and Toolbar Buttons Page Display Format
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Book Reader Page Selection in a Displayed Document
Choose any of several methods to go to a specified page in the displayed
Book Reader document

Method 1–Use the Document menu or Go to page button

To go to a specific page in a document:
Either
Select a type of page from the View menu

Or

1. Select Go To Page on the View menu or the Page x of x button
on the bottom toolbar.

2. Specify the number of the page to display.

Document Menu and Toolbar Button Go to Page

Method 2–Select a bookmark in the left pane

The bookmarks in the left pane display all of the headings that appear
in the selected manual. You can go to the page for that heading by
simply clicking the bookmark.
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To display a page using the left pane bookmark:
1. Move the mouse pointer over the name of the topic you want to

display.

The cursor changes to a pointing hand .

2. Click the topic name.

The page containing that topic displays in the Page pane.

Method 3–Use Buttons or keys to page forward and backward

You can also use the arrow buttons on the Toolbar, your keyboard keys
or items on the View menu to page through a document.

To go to page Click Press

Next Right or down arrow

Previous Left or up arrow

First Home key

Last End key

The following buttons let you retrace your steps.
Go to the Previous page
or magnification
Reverse direction and
return, one view at a
time, to the view where
you first used Go Back
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Selected Text in an Active Document
The Find tool enables you to find part of a word, a complete word or
multiple words in active document (the document that is open and being
displayed).   

 To find a word in an active document:

1. Click  on the Toolbar or select Find from the Tools menu.
The Acrobat Find dialog box opens.

2. Enter the text you want to search for in the Find What field.
3. Select the check boxes for the type of search you want to perform.
4. Click Find.

When the Book Reader locates the text the page displays and the
text is highlighted.

5. Press Ctrl+G to re-open the dialog box and find the next
occurrence of the text in the document.

Selected Text in Multiple Documents
The Search tool enables you to perform a full-text search on multiple
documents.

4. Make sure the CIMPLICITY HMI Documentation index is
selected.
You should not need to select indexes to search. The  online
documentation currently has only one index.

5. Click OK to close the dialog box.
6. Either:

Method 1

Click  on the Toolbar
Method 2
A. Click Tools on the menu bar.
B. Select Search.
C. Select Query.
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The Adobe Acrobat Search dialog box opens.

7. Type the text you want to find in the Find Results Containing
Text field.

8. Click Search.
The Adobe Acrobat Search dialog box closes and the Search
Results dialog box opens with a list of all the documents that
contain the text.

9. Double-click a document in this list to open it.

The document opens when the search finds the first match for the
text you typed.

10. Choose any of the following methods to go to the next or previous
matches.
Method 1

Use the  or  buttons

Method 2

A. Select Tools on the menu bar.
B. Select Search.
C. Select Next or Previous.
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Tip: If you close the Search Results dialog box, you can click the 
button on the Toolbar to reopen it.

Expand/Limit a Text Search in Multiple Documents
The options in the Adobe Acrobat Search dialog box enable you to expand
or limit your search.  The options are:

Word Stemming Expands the search to find words that share a
word stem with the word you type.

Sounds Like Expands the search for a proper name by finding
words that begin with the same letter and share
phonetic features.

Thesaurus Expands the search to find words with meanings
similar to that of the search word.

Match Case Limits the search to find only those words that
match the case of the search word.

Proximity Limits the results of simple AND searches to one
pair of matches per document.  The matches
must be within three or fewer pages of each
other.

Doing Boolean Searches for Text in Multiple Documents
You can use AND, OR and NOT operators in the Find Results
Containing Text field to perform Boolean searches for combinations of
text.

Guidelines for using Adobe Acrobat reader, which is used by
the CIMPLICITY HMI Book Reader

� There are no jumps from the Contents or Index pages of the
documentation.  If you find an entry in the Contents or Index, you
can use the Find tool to find the word in the body of the
document, or to find the page number.

� If you are accessing online documentation over a network share,
the DOC directory must be on a mapped drive (such as X:\doc).
The index will not work with a UNC path name (such as
\\computer\share\doc).

� If you see books listed multiple times in your search results, it
means you have the index file loaded multiple times.

To remove duplicate index entries:
1. Click Tools on the menu bar.
2. Select Search>Indexes.
3. Remove any duplicate index entries.
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Printed Documentation
Contact you GE Fanuc Automation distributor to purchase one or more
printed manuals. When you order, use the product numbers for the manuals
listed below.
Following is a list of CIMPLICITY HMI manuals, including manuals for
options. They can be accessed in an online help version, electronically
through the Book Reader, in addition to being purchased in print from GE
Fanuc Automation.

GFK-1189R* CIMPLICITY HMI Plant Edition Important Product Information
GFK-1500C* CIMPLICITY HMI Plant Edition Getting Started
GFK-1180K* CIMPLICITY HMI Plant Edition Base System User's Manual
GFK-1396F* CIMPLICITY HMI Plant Edition CimEdit Operation Manual
GFK-1181J* CIMPLICITYHMI Plant Edition Device Communications Manual
GFK-1548A CIMPLICITY Action Calendar Manual
GFK-1305D* CIMPLICITY HMI Plant Edition Basic Control Engine Program Editor Operation

Manual
GFK-1282F* CIMPLICITY Basic Control Engine Event Editor Operation Manual
GFK-1283G* CIMPLICITY Basic Control Engine Language Reference Manual
GFZ-
62994EN/01

CIMPLICITY Basic Operation Package 1 Operator's Manual

GFK-1341G* CIMPLICITY for CNC Operation Manual
GFK-1342H* CIMPLICITY CNC Important Product Information
GFK-1379C CIMPLICITY Historical Data Analyzer Operation Manual
GFK-1461B CIMPLICITY Integrator's Toolkit Application Developer Guide
GFK-1405C CIMPLICITY Marquee Driver Operation Manual
GFK-1675 CIMPLICITY OPC Server Operation Manual
GFK-1303D CIMPLICITY Recipes Operation Manual
GFK-1353F* CIMPLICITY HMI Plant Edition Server Redundancy Manual
GFK-1752A CIMPLICITY SQL Getting Started Guide
GFK-1413E CIMPLICITY Statistical Process Control Operation Manual
GFK-1632B* CIMPLICITY HMI Plant Edition System Sentry Operation Manual
GFK-1692C* CIMPLICITY HMI Plant Edition ThinView Operation Manual
GFK-1694B* CIMPLICITY HMI Plant Edition Tracker Getting Started Guide
GFK-1216F* CIMPLICITY HMI Plant Edition Tracker Production Tracking Operation Manual
GFK-1408C* CIMPLICITY HMI Plant Edition Tracker Routing Control Objects Operation Manual
GFK-1260H* CIMPLICITY HMI Plant Edition Trend and XY Chart Operation Manual
GFK-1668B* CIMPLICITY HMI Plant Edition Web and Terminal Services Operation Manual
GFK-1993** CIMPLICITY HMI Plant Edition Alarm Viewers Operation Manual

GFK-2024** CIMPLICITY HMI Plant Edition GagePort Mitutoyo OPC Server Operation Manual

* = Revised manuals; **  = New manuals
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